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2.

User Guide (Print)

Overview

Print Drivers

The print drivers for this machine are multi-environment drivers
designed to enable printing from the workstation to a DocuColor
2240/1632 on the network. The print drivers contain a variety of
feature options which enable you to customize your print jobs. The
DocuColor 2240/1632 supports Adobe PostScript 3 version
3011.106, and PCL 6/5e Version 4.1.
Print drivers for this machine are included on the CD-ROM that
came with your printer. Print drivers are installed on the user
workstation to enable fast, efficient printing from your connected
workstation.
Print driver installation procedures are provided for the following
workstation environments:

Basic Printing
Special Printing
Internet Services

12

•

Windows 95, 98, and Windows Me

•

Windows NT 4.0

•

Windows 2000 and Windows XP

•

Macintosh

This section explains how to perform basic printing tasks.
The Special Printing section explains how to program special
printing such as printing with special papers, and adjusting colors.
When the machine is in TCP/IP environment, Internet Services
allows the user to change or check printer settings via a web
browser.
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U SE R G U I D E ( P R I N T )

This chapter describes how to install print drivers for basic and
special printing. It also explains the use of Internet Services,
printing features and all the necessary steps for printing.
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Printer Environments
This machine can be set up in many different environments.
•

When connected to a computer directly, it can be used as
a local printer.

•

When connected to a network, it can be used as a network
printer.

This section explains the different printer environments that can
be set up for this machine.
For details on how to connect this machine to a network, refer to
the System Administrator’s Guide.

As a Local Printer
Using parallel interface connects this machine directly to a
computer.

CAUTION: Use only parallel interface cable provided by our
company. Using a parallel interface cable from another source
may lead to electric wave obstruction.
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As a Network Printer
Windows Network (SMB)
Server Message Block (SMB) is a protocol for sharing files or a
printer on Windows 95, Windows 98, Windows Me, Windows NT
4.0, Windows 2000, and Windows XP. Using SMB, print data or
settings can be sent directly to a printer on the same network
(Ethernet interface) without going through a server.
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For details on how to connect this machine to a Windows network
using SMB, refer to the System’s Administrator’s Guide.

TCP/IP (LPD)
This machine supports TCP/IP (LPD). The different connections
are briefly explained below.
For details on how to connect this machine to a Windows
computer using TCP/IP, refer to the System’s Administrator’s
Guide.
Windows 95/98/Me

Using our TCP/IP Direct Print Utility, print data can be sent directly
to a printer on the same network (Ethernet interface) without going
through a server. TCP/IP Direct Print Utility is installed together
with the print driver.
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Windows NT 4.0/2000/XP

Using the LPR port for the operating system, print data can be
sent directly for printing.
Once the printer registered on a Windows NT 4.0, Windows 2000,
or Windows XP computer is shared, you can also send data from
Windows 95, Windows 98, Windows Me to the shared printer for
printing.

Internet Printing

This machine supports Internet Printing Protocol (IPP). Using IPP,
you can print to a remote printer through the internet or intranet.
For details on how to set-up Internet printing from a Windows
2000, Windows XP, or Windows Me through Internet Printing
Protocol, refer to the System Administrator’s Guide.

NetWare

This machine can be used as a network operating system in an
environment using Novell NetWare.
For details on how to connect this machine to a Novell NetWarenetwork, refer to the System Administrator’s Guide.
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EtherTalk (optional)

This machine supports EtherTalk protocol, and enables you to
print from Macintosh.

Token Ring (optional)

This machine supports Token Ring. And when installed with the
optional interface board for Token Ring, you can use the printer in
a network environment with NetWare or TCP/IP existing alone or
together.
For details on how to connect this machine to a Windows
computer using TCP/IP refer to the System Administrator’s Guide.
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For details on how to connect this machine to EtherTalk, refer to
the System Administrator’s Guide.
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A.

Installing the Print Drivers

Overview

•

Windows 95, Windows 98, or Windows Me

•

Windows NT 4.0

•

Windows 2000 and Windows XP

•

Macintosh
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This section details the procedures for installing PostScript 3
Version 3011.106, and PCL 6/5 Version 4.1, print drivers onto a
workstation and setting the print driver properties for the following
operating systems.
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Windows 95/98/Me

Installing PostScript or PCL Print Driver
Prior to installing the AdobePS 4.4.X or PCL 6/5e Version 4.1 print
driver perform the following.
•

Obtain the Print Driver for your workstation's operating
system. Drivers are available on a CD-ROM that came
with your Printer. They are also typically available for
downloading in self-extracting Zip file format from the
internet at www.xerox.com.

•

Obtain the printer’s IP Address by printing a System
Settings List or contacting your System Administrator.

•

Check that the machine is physically connected to the
network or to your computer.

For detailed instructions on how to connect the machine to a
network, refer to the System Administrator’s Guide.

1
2
3
4

From the Start menu on the Windows desktop, select Settings,
and then Printers.
In the Printers window, double click Add Printer. The Add Printer
Wizard screen is displayed.
Select Next. The Local or Network Printer screen is displayed.
Select how the printer is connected to your computer and then
select Next.
•

Select My Computer or Local Printer if the Printer is
directly cabled to your desktop or you are printing through
a Spooler Utility (Windows 95/98/Me).

•

Select Network Printer if you will be printing through a
print queue or a network server.

NOTE: If you select Network printer, specify the path to the printer
in the Network path or queue name.
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5
6
7

Insert the CD-ROM in the CD-ROM drive.
When the Manufacturers and Printers window displays, select
Have Disk…. The Install From Disk screen is displayed.
Enter the path for your driver files in the “Copy manufacturer’s files
from:” box.
NOTE: You can also use the Browse button to specify a folder on
the CD-ROM.

11
12
13
14
15
16
17

Select OK on the Install From Disk or Open screen.
Select your printer model from the Printers list and select Next.
Select the port that you are using from the Available ports list, then
select Next.
When prompted, accept the default printer name, or give your
printer a more descriptive name.
Select either Yes or No to make this printer your default Windows
printer. Choose Yes if you will be printing primarily to this printer
from your Windows applications. Select Next.
Print a Test Page.
Verify that the test page prints at the printer, then select Finish.
Read the End User License Agreement and select Accept.
Confirm that the printer has been added in the Printers window.
Continue to the next page in order to configure the print driver to
complete the installation.
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8
9
10
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Configuring the PostScript Print Driver on Windows 95/98/Me
This section describes printer specific settings included in the print
driver properties.
•

Configuration Tab

•

Options Tab

•

Output Settings Tab

•

Color Settings Tab

To view the print driver properties, select the printer icon in the
Printers window, then select the Properties command on the File
menu.
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Configuration Tab Settings
This section describes the settings of the Configuration tab.

Select the function that you want to set in Features List.
•

2

Change the settings in the “Change Setting For” box area.
•

3

The settings that can be selected vary depending on which
options have been installed. Make these settings after
confirming that option settings are complete.

You can restore defaults by selecting the Restore
Defaults button.

When all setting changes are completed, select OK.

Feature Settings
Image Enhancement

Specify whether to use the Image Enhancement function.
Selecting On, smooths out the boundaries between black and
white when printing. This reduces jagged edges, thereby
artificially increasing the resolution of the image. When printing an
image (bitmap) composed of coarse halftone dots, smooth color
gradation is impossible in certain situations. In this case, select
Off.
NOTE: The Image Enhancement feature is available only when
Print Mode is set to High Speed.

Draft Mode

Specify whether to reduce the amount of toner used when printing
drafts. When you select On, the overall printed color becomes
lighter. This is best for printing documents when print quality is not
necessary.
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Transparency Separators

Specify whether to use transparency separators and the source of
the separators.
Select Auto for the paper source to automatically feed from the
paper tray with paper of the same size and in the same orientation
as the transparencies.
NOTE: When using Transparency Separators, be sure to load
paper of the same size and in the same orientation as
transparencies into the paper tray.
NOTE: The Transparency Separators function cannot be used in
the following situations:

Stapling

•

When anything other than Manual feed is selected for
Paper source in the Paper tab.

•

When anything other than Transparency is selected for
Paper type in the Paper tab.

•

When anything other than Center Output Tray is selected
for Output bin in the Paper tab.

•

When the Duplex feature is selected in the Paper tab.

Specify whether to staple printed documents as well as the
position of the staple.
NOTE: You can staple 2 to 50 sheets.
NOTE: You cannot use staples in the following situations:

Job Offset

When anything other than Finisher Tray is selected for
Output bin in the Paper tab.

•

When Job Offset is selected.

Shifting the output positions of adjacent jobs (print command) or
copies (sets) is called Job Offset. The positions of adjacent jobs or
sets of copies are shifted to either sides of the output tray.

Collated

Select whether to collate a multi-page file per set when they are
printed.

Custom Paper Image
Rotation

Select whether to correct the paper orientation when printing on
custom paper. When printing on custom paper, select On to
correct the orientation rotated at 90 degrees.

Bypass Feed Orientation
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•

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape. When you set the long side of the
paper in the bypass tray, select Portrait.
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Substitute Tray

Specify what action to take when the paper size called for is not
loaded in the machine.
Use Printer Settings: The settings can be confirmed on the
printer control panel.
Display message: Display paper supply messages on the printer
control panel. Printer will be unavailable until paper is supplied.
Use Nearest Size (With Zoom): Select the nearest paper size.
Automatically reduces or enlarges images for printing, as
necessary.

Use Larger Size (With Zoom): Print in equal size on paper larger
than the original. Automatically reduces images for printing, as
necessary.
Use Larger Size (No Zoom): Print on paper larger than the
original.
Available Printer Memory

Enter the amount of usable printer memory (in KB) in the Edit box.
Normally, it is not necessary to change this setting.

Available Font Cache

Enter the amount of memory available for the font cache (in KB) in
the Edit box. Normally, it is not necessary to change this setting.
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Use Nearest Size (No Zoom): Select the nearest paper size
available and prints in equal size.
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Specify Job Owner

The following selections are available:
Use Login Name: Use your Windows Login Name as the Job
Owner Name. The Job Owner Name becomes the “Login User
Name\Host Name”.
Enter Owner name: Select this if you want to specify a custom
Job Owner Name, which is used for all the printer icons.
NOTE: You can enter up to 31 alphanumeric characters for the
Login Name and the Owner Name. If you enter more than 31
characters for either name, only the first 31 characters are used.
Password: Enter the password for the Job Owner Name. The
password can consist of 4 to 12 digits. Each digit entered displays
as an asterisk (*).

Job Type User ID

Enter the User ID for the Job Type, which includes Secure Print,
Sample Print, and Delayed Print.
Job Type User ID: Enter the User ID for the Job Type. The User
ID can contain a maximum of 24 alphanumeric characters.
Password: Enter the password for the Job Type. You can enter
up to 4 digits. Each digit entered displays as an asterisk (*).

Options Tab Settings
This section describes the settings of the Options tab.

1
2

Select the settings that you want to set in Hardware Options.
Change the settings in the “Change Settings For” box area.
•

3
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You can restore defaults by selecting the Restore
Defaults button.

When all setting changes are completed, select OK.
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Settings
Output Tray
Paper Detect by Tray

Specify whether Finisher is installed and the type.
Specify either Statement Paper Detection, or A5 Paper Detection.

Output Settings Tab Settings
This section describes the settings in the Output Settings tab.
•

You can restore defaults by selecting the Restore
Defaults button.

Output Size

Select the size of the paper used for output. The output is
automatically enlarged or reduced, depending on the paper size
selected in the Output Size and the paper size selected in the
Paper tab.
Example: When you select 8 1/2 x 11 inches in Paper size
in the Paper tab and 11 x 17 inches is selected in the
Output Size, the output is automatically enlarged and
printed.
When None is selected the job is printed based on the paper size
selected in the application.
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Output Paper
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Job Type
Job Type

You can specify the print function from among Secure Print,
Sample Print, and Delayed Print.
Secure Print: A function that temporarily stores print jobs in the
printer, and prints the job when instructed from the printer control
panel.
•

If you want to output secure prints, set the User ID and
password for Print Type in the Configuration tab.

Sample Print: A function that outputs only 1 set when multiple
sets are specified. If the job is as specified, the remaining sets are
printed.
Delayed Print: A function that temporarily stores print jobs in the
printer, and prints them at a scheduled time.
Normal Print

Select when you do not want to output secure prints, sample
prints, or delayed prints.

Secure Print

Select when you want to output secure prints.

Sample Print

Select when you want to output sample prints.
NOTE: The Collated setting must be selected in the Page Setup
tab when using Job Type.

Delayed Print

Select when you want to output delayed prints.

User ID

Displays the User ID for Job Type. The User ID displayed is the
User ID specified on the Configuration tab. This option can only be
selected when the setting on the Configuration tab has been
completed. This is a display-only item and cannot be changed in
User ID.

Password

Displays the Job Type password specified in the Configuration
tab. Each digit entered is displayed as an asterisk (*). This option
can only be selected when the setting on the Configuration tab
has been completed. This is a display-only item and cannot be
changed in Password.

Retrieve Document Name

Select the method of specifying the document name. If you have
selected Auto Retrieve, the valid document name can be up to 24
alphanumeric characters.

Document Name

Start Print Time

When “Enter Document Name” is selected in the Stored
Document Name list, you can specify a document name with a
maximum of 24 alphanumeric characters.
Set the time that you want Delayed Print to be carried out. Place
the cursor in the hour or minute box and press the up or down
triangle to specify the starting time. You can also set the time by
entering the time directly into the boxes.
•
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The default setting is 00:00
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Color Settings Tab Settings
Settings
Output Color
Print Mode

Specify whether to print in color or black.
Specify whether to give priority to the print speed or the image
quality. The printer/copier is capable of printing at three different
resolutions:
High Speed: 600 x 600
Standard: 1200 x 600
High Quality: 1200 x 1200
NOTE: The Image Enhancement feature is not available when
Standard or High Quality is selected.

RGB Color Correction

Specify the coloration of the RGB Color Correction.
Normal: This setting is optimized for printing documents that
contain text and graphics, such as business documents.
Photo: This setting is optimized for printing photos or images with
gradations. Select this setting when printing images in RBG.
Web Pages: This setting is optimized for printing web pages.
Presentation: This setting is optimized for printing the color
documents vividly, such as presentation documents.

Screen

You can adjust the image quality. Select Gradation to print photos
and gradations clearly. Select Fineness to print the colors in
illustrations, tables, or graphs evenly.

RBG Gamma Correction

Specify the brightness of the documents. The higher the value, the
darker the print becomes.

Gray Guaranteed

Select On to print grays and black within documents in black toner
only. This prevents neutral grays from exhibiting any kind of color
shading or misregistration. This feature does not apply to images
of the documents.
NOTE: For documents containing sweeps/gradients that include
gray, it may be preferable to set this feature to Off.
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To change resolution settings, use the Print Mode selections.
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Configuring the PCL Print Driver on Windows 95/98/Me
This section describes the following printer specific settings
included in the PCL 6/5e Version 4.1 Print Driver Properties and
Printing Preferences.
•

Print Driver Properties

•

Configuration Tab > Print Features
Printer Tab

•

Document Default Properties
Watermarks
Fonts
User Settings
Color Management
Paper Output
Output Options
Graphics

Print Driver Properties

•

Configuration Tab

•

Printer Tab

To view the Configuration or Printer tabs, select the printer icon in
the printers window, then select Properties on the File menu.
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Configuration Tab Settings
This describes Print Features in the Configuration tab.

1
2
3
4
5

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Configuration tab.
Select the items in Print Features that you want to set.
Change the settings in the list box that is displayed below the Print
Features list.
When all setting changes are completed, select OK.
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NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.

USER GUIDE (PRINT)

Print Features
Print Page Mode
Specify Job Owner

Set Print Page Mode to On to enhance printer performance with
large complex jobs.
Use this feature to specify a job owner.
Use Login Name: Use your Windows Login Name as the Job
Owner Name. The Job Owner Name becomes the “Login User
Name\Host Name”.
Enter Owner Name (For Administrator): Select this if you want
to specify a custom Job Owner Name, which is used for all the
printer icons.
Enter Owner Name (For User): Select this if you want to specify
a custom Job Owner Name for each Windows Login user.
NOTE: You can enter up to 31 alphanumeric characters for the
Login Name and the Owner Name. If you enter more than 31
characters for either name, only the first 31 characters are used.
Password: Enter the password for the Job Owner Name. The
password can consist of 4 to 12 digits. Each digit entered displays
as an asterisk (*).

Bypass Feed Orientation

Substitute Tray

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape setting. When you set the long side of
the paper in the bypass tray, select Portrait setting.
Specify what action to take when the paper size called for is not
loaded in the machine.
Use Printer Settings: The settings can be confirmed on the
printer control panel.
Display message: Displays paper supply messages on the
printer control panel. Printer will be unavailable until paper is
supplied.
Use Nearest Size (With Zoom): Selects the nearest paper size.
Automatically reduces or enlarges images for printing, as
necessary.
Use Nearest Size (No Zoom): Selects the nearest paper size
available and prints in equal size.
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Printer Tab Settings
This describes the available Printer tab settings.

1
2
3
4
Finisher
A5 & Statement Paper
Detection

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Printer tab.
Select the Auto Configuration button or select the items
manually in Change Setting For: that you want to set.
When all setting changes are completed, select OK.
An optional output tray with stapling function that can be added to
the side of the printer.
Optional output functions to enable Trays 1 - 4 to detect certain
paper sizes.
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NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.
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Document Default Properties
This describes the document default properties available in the
Properties dialog box.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.
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2

3

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the appropriate tab to view or change the document default
properties for all users of the selected printer. Select your changes
on the following tabs:
•

Color Management

•

Paper/Output

•

Output Options

•

Graphics

•

Watermarks

•

Fonts

•

User Settings
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1

When all setting changes are completed, select OK.
Specify your printing options from the following:
For additional detail about the contents on the tabs use On-line
Help. For more information, refer to the B. Basic Printing section in
this chapter.

Color Management
Paper/Output Tab

Allows you to associate color profile (s) with your color printer.
Selections include Job Type, Copies, Paper Size, Output Size,
Image Orientation, Mixed Orientation, Multiple Up, Output Color, 2
Sided Print, Output Destination, Paper Source, Paper Type
(Bypass Tray), or select Printer Status, Poster/Booklet, Print Area,
or Restore Defaults buttons.
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Output Options Tab

Graphic Tabs

Select from Front Cover, Feed Cover from, Transparency
Separators, Job Offset, Stapling, or select Margin Shift Restore
Defaults buttons.
Specify how you want to manipulate graphic images for your print
job. Select from the following options: Output Color, Print Mode,
Image Adjustment Mode, Image Types, Image Auto Correction, or
select the Image Settings, Color Balance, Profile Settings,
Detailed Settings, or Restore Defaults buttons.
For more information on how to set graphic options refer to section
C.) Special Printing in the User Guide (Print).

Watermarks Tab

Fonts Tab
User Settings Tab
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Specify watermark settings. Selections for watermarks include
First Page Only or In Background, Encircle, Text, Position, Angle,
or select the Restore Defaults button.
Use the TrueType Font control to select how TrueType Fonts will
be processed and printed.
The User Settings tab dialog provides options for you to save
frequently used print driver settings and then recall these settings
without having to configure again.
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Windows NT 4.0

Installing PostScript or PCL Print Driver

•

Obtain the Print Driver for your client's operating system.
Print drivers are available on a CD-ROM that came with
your machine. They are also typically available for
downloading in self-extracting Zip file format from the
internet at www.xerox.com.

•

Obtain the printer’s IP Address by printing a System
Settings List or contacting your System Administrator.

•

Check that the machine is physically connected to the
network or to your computer.

For detailed instructions on how to connect the machine to a
network, refer to the System Administrator’s Guide.

1
2
3
4
5

From the Start menu on the Windows desktop, select Settings,
and then Printers.
In the Printers window, double click Add Printer. The Add Printer
Wizard screen is displayed.
Verify that My Computer is selected, then select Next. The
Available ports screen is displayed.
Perform one of the following steps:
•

Select an existing available port and continue to step 8.

•

Select Add Port....

Select LPR Port from the Available Printer Ports list, and then
select New Port.... The Add LPR compatible printer screen is
displayed.
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Prior to installing the AdobePS 4.4.X or PCL 6/5e Version 4.1 print
driver perform the following.
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6

7

In the LPR Compatible Printer screen enter the following
information:
•

Type in the IP address of the Printer for the “Name or
address of server providing lpd.”

•

Type in the case-sensitive name of your Printer, or enter
the word raw for “Name of printer or print queue on that
server.”

•

Select OK.

On the Print Ports screen, select Close.
•

The Wizard will return you to the previous dialog box.
Verify the new IP address you entered is in the list and
correct.

NOTE: In the next step the port check box to the left of the
address must be checked prior to selecting Next.

8
9
10
11

Verify that the port check box is checked, then select Next. The
Manufacturers and Printers lists are displayed.
Insert the CD-ROM in the CD-ROM drive.
Select Have Disk… The Install From Disk screen is displayed.
Enter the path for your driver files in the “Copy manufacturer’s files
from:” box.
NOTE: You can also use the Browse button to specify a folder in
the CD-ROM.

12
13
14
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Select the .INF file, then select Open.
When the Install From Disk screen is displayed, verify that the
path and file name are correct and select OK.
Select your printer model from the Printers list, and select Next.
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16
17
18
19
20
21
22

When prompted, accept the default printer name, or give your
printer a more descriptive name, then select Yes or No for making
this your Windows default printer.
Select Next.
Select Not shared and select Next.
Select Yes to print a test page, then select Finish.
Read the End User License Agreement and select Accept.
Verify that the test page prints at the printer, then select Yes.
Confirm that the printer has been added in the Printers window.
Continue to the next page in order to configure the print driver to
complete the installation.
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15
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Configuring PostScript Print Driver on Windows NT 4.0
This section describes the following Adobe PostScript printer
specific settings included in the AdobePS 4.4.X print driver
properties and document defaults.

Print Driver Properties

•

Installation Options in the Device Settings Tab

•

Configuration Tab

To view the Device Settings or Configuration tabs, select the
printer icon in the Printers window, then select Properties from
the File menu.

2–28

USER GUIDE (PRINT)

Installable Options Settings
This section describes Installable Options in the Device Settings
tab.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.

2
3

Select the items you want to set in Installable Options on the
Device Settings tab.
Change the settings in the Change Setting box located at the
bottom of the tab.
When all setting changes are completed, select OK.

Settings
Output Tray
Paper Detect by Tray

Specify whether Finisher is installed and the type.
Specify either Statement Paper Detection, or A5 Paper Detection.
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1
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Configuration Tab Settings
This section describes the settings of the Configuration tab.

Specify Job Owner
Use Login Name

Use your Windows Login Name as the Job Owner Name. The Job
Owner Name becomes the “Login User Name\Host Name”.

Enter Owner Name (For
Administrator)

Select this if you want to specify a custom Job Owner Name,
which is used for all the printer icons.

Enter Owner Name (For
User)

Select this if you want to specify a custom Job Owner Name for
each Windows Login user.
NOTE: You can enter up to 31 alphanumeric characters for the
Login Name and the Owner Name. If you enter more than 31
characters for either name, only the first 31 characters are used.

Password

Enter the password for the Job Owner Name. The password can
consist of 4 to 12 digits. Each digit entered displays as an asterisk
(*).

Job Type User Setting
Enter the User ID and password for the Job Type, which includes
Secure Print, Sample Print, and Delayed Print.
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User ID

Enter the User ID for Print Type. The User ID can contain up to a
maximum of 24 alphanumeric characters.

Password

Enter the password for the Job Type. You can enter up to 4 digits.
Each digit entered displays as an asterisk (*).
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•

Printer Specific Sections in the Printer Features of the
Advanced Tab

•

Output Settings Tab

To view the Advanced or Output Settings tabs, select the printer
icon in the Printers window, then select Document Defaults on
the File menu.
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Print Driver Document Defaults
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Advanced Tab Settings
This section describes the settings of Printer Features in the
Advanced tab.
NOTE: The settings that can be selected vary depending on which
options have been installed.

1
2
3

2–32

Select the items in Printer Features under Document Options
located in the on the Advanced tab that you want to set.
Change the settings in the Change Setting box located at the
bottom of the tab.
When all setting changes are completed, select OK.
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Printer Features Settings
Output Tray

Set the destination for the output.
•

The items that can be selected vary according to whether
the Center Tray or Finisher has been installed.

Job Offset

Shifting the output positions of adjacent jobs (print command) or
copies (sets) is called Job Offset. The positions of adjacent jobs or
sets of copies are shifted to either sides of the output tray.

Transparency Separators

Specify whether to use transparency separators and the source of
the separators.

NOTE: When using Transparency Separators, be sure to load
paper of the same size and in the same orientation as
transparencies into the paper tray.
NOTE: The Transparency Separators function cannot be used in
the following situations:
•

When anything other than Manual feed is selected for
Paper source in the Paper tab.

•

When anything other than Transparency is selected for
Media type in the Advanced tab.

•

When anything other than Center Output Tray is selected
for Output Destination of Printers Features in the
Advanced tab.

Bypass Feed Orientation

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape. When you set the long side of the
paper in the bypass tray, select Portrait.

Print Mode

Specify whether to give priority to the print speed or the image
quality. The printer/copier is capable of printing at three different
resolutions:
High Speed: 600 x 600
Standard: 1200 x 600
High Quality: 1200 x 1200
To change resolution settings, use the Print Mode selections.
NOTE: The Image Enhancement feature is not available when
Standard or High Quality is selected.
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Select Auto for three paper source to automatically feed from the
paper tray with paper of the same size and in the same orientation
as the transparencies.
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Output Color
RBG Color Correction

Specify whether to print in color or black.
Specify the coloration of the RBG Color Correction.
Normal: This setting is optimized for printing documents that
contain text and graphics, such as business documents.
Photo: This setting is optimized for printing photos or images with
gradations. Select this setting when printing images in RBG.
Web Pages: This setting is optimized for printing web pages.
Presentation: This setting is optimized for printing the color
documents vividly, such as presentation documents.

RBG Gamma Correction

Specify the brightness of the documents. The higher the value, the
darker the print becomes.

Screen

You can adjust the image quality. Select Gradation to print photos
and gradations clearly. Select Fineness to print the colors in
illustrations, tables, or graphs evenly.

Image Enhancement

Specify whether to use Image Enhancement.
Selecting On, smooths out the boundaries between black and
white when printing. This reduces jagged edges, thereby
artificially increasing the resolution of the image. When printing an
image (bitmap) composed of coarse halftone dots, smooth color
gradation is impossible in certain situations. In this case, select
Off.
NOTE: The Image Enhancement feature is available only when
Print Mode is set to High Speed.

Draft Mode

Specify whether to reduce the amount of toner used when printing
drafts. When you select On, the overall printed color becomes
lighter. This is best for printing documents when print quality is not
necessary.

Gray Guaranteed

Select On to print grays and black within documents in black toner
only. This prevents neutral grays from exhibiting any kind of color
shading or misregistration. This feature does not apply to images
of the documents.
NOTE: For documents containing sweeps/gradients that include
gray, it may be preferable to set this feature to Off.
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Select whether to staple printed documents as well as the position
of the staple.
•

You can staple 2 to 50 sheets.

•

You can only staple when Finisher Tray is selected for
Output Destination in the Advanced tab.

•

You cannot use staples when Job Offset is selected.

Custom Page Image
Rotation

Select whether to correct the paper orientation when printing on
custom paper. When printing on custom paper, select On to
correct the orientation rotated at 90 degrees.

Substitute Tray

Specify what action to take when the paper size called for is not
loaded in the machine.
Use Printer Settings: The settings can be confirmed on the
printer control panel.
Display message: Display paper supply messages on the printer
control panel. Printer will be unavailable until paper is supplied.
Use Nearest Size (With Zoom): Select the nearest paper size.
Automatically reduces or enlarges images for printing, as
necessary.
Use Nearest Size (No Zoom): Select the nearest paper size
available and prints in equal size.
Use Larger Size (With Zoom): Print in equal size on paper larger
than the original. Automatically reduces images for printing, as
necessary.
Use Larger Size (No Zoom): Print on paper larger than the
original.
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Stapling
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Output Settings Tab Settings
This section describes the settings in the Output Settings tab.

Job Type
Job Type

You can specify the print function from among Secure Print,
Sample Print, and Delayed Print.
Secure Print: A function that temporarily stores print jobs in the
printer, and prints the job when instructed from the printer control
panel.
•

If you want to output secure prints, set the User ID and
password for Print Type in the Configuration tab.

Sample Print: A function that outputs only 1 set when multiple
sets are specified. If the job is as specified, the remaining sets are
printed.
Delayed Print: A function that temporarily stores print jobs in the
printer, and prints them at a scheduled time.
Normal Print

Select when you do not want to output secure prints, sample
prints, or delayed prints.

Secure Print

Select when you want to output secure prints.

Sample Print

Select when you want to output sample prints.
NOTE: The Collated setting must be selected in the Page Setup
tab when using Job Type.

Delayed Print
User ID
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Select when you want to output delayed prints.
Displays the User ID for Job Type. The User ID displayed is the
User ID specified on the Configuration tab. This option can only be
selected when the setting on the Configuration tab has been
completed. This is a display-only item and cannot be changed in
User ID.

Password

Displays the Job Type password specified in the Configuration
tab. Each digit entered is displayed as an asterisk (*). This option
can only be selected when the setting on the Configuration tab
has been completed. This is a display-only item and cannot be
changed in Password.

Retrieve Document Name

Select the method of specifying the document name. If you have
selected Auto Retrieve, the valid document name can be up to 24
alphanumeric characters.

Document Name

When Enter Document Name is selected in the Stored Document
Name list, you can specify a document name with a maximum of
24 alphanumeric characters.

Start Print Time

Set the time that you want Delayed Print to be carried out. Place
the cursor in the hour or minute box and press the up or down
triangle to specify the starting time. You can also set the time by
entering the time directly into the boxes.
•

The default setting is 00:00
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Configuring the PCL Print Driver on Windows NT 4.0
This section describes the following printer specific settings
included in the PCL 6/5e Version 4.1 Print Driver Properties and
Printing Preferences.
•

Print Driver Properties
Configuration Tab > Print Features
Printer Tab

•

Document Defaults

Print Driver Properties

•

Configuration Tab

•

Printer Tab

To view the Configuration or Printer tabs, select the printer icon in
the Printers window, then select Properties on the File menu.
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Configuration Tab Settings
This describes Print Features in the Configuration tab.

1
2
3
4
5

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Configuration tab.
Select the items in Print Features that you want to set.
Change the settings in the list box that is displayed below the Print
Features list.
When all setting changes are completed, select OK.
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NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.
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Print Features
EMF Spooling

Print Page Mode
Specify Job Owner

Select On to specify the spool format of the print data in the hard
drive as RAW format. As it takes time to convert print data, the
processing time is extended.
Select Print Page Mode to On to enhance printer performance
with large complex jobs.
Use this feature to specify a job owner.
Use Login Name: Use your Windows Login Name as the Job
Owner Name. The Job Owner Name becomes the “Login User
Name\Host Name”.
Enter Owner Name (For Administrator): Select this if you want
to specify a custom Job Owner Name, which is used for all the
printer icons.
Enter Owner Name (For User): Select this if you want to specify
a custom Job Owner Name for each Windows Login user.
NOTE: You can enter up to 31 alphanumeric characters for the
Login Name and the Owner Name. If you enter more than 31
characters for either name, only the first 31 characters are used.
Password: Enter the password for the Job Owner Name. The
password can consist of 4 to 12 digits. Each digit entered displays
as an asterisk (*).

Bypass Feed Orientation

Substitute Tray

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape. When you set the long side of the
paper in the bypass tray, select Portrait.
Specify what action to take when the paper size called for is not
loaded in the machine.
Use Printer Settings: The settings can be confirmed on the
printer control panel.
Display message: Display paper supply messages on the printer
control panel. Printer will be unavailable until paper is supplied.
Use Nearest Size (With Zoom): Select the nearest paper size.
Automatically reduces or enlarges images for printing, as
necessary.
Use Nearest Size (No Zoom): Select the nearest paper size
available and prints in equal size.

2–40

USER GUIDE (PRINT)

Printer Tab Settings
This describes Printer tab.

1
2
3
4
Finisher
A5 & Statement Paper
Detection

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Printer tab.
Select the Auto Configuration button or select the items
manually in Change Setting For: that you want to set.
When all setting changes are completed, select OK.
An optional output tray with stapling function that can be added to
the side of the printer.
Optional output functions to enable Trays 1 - 4 to detect certain
paper sizes.
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NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.
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Document Defaults
This describes the Document Defaults.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.
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2

3

Select the printer icon in the Printers window, then select
Document Defaults from the File menu.
Select your changes on the following tabs:
•

Paper/Output

•

Output Options

•

Graphics

•

Watermarks

•

Fonts

•

User Settings

When all setting changes are completed, select OK.
Specify your printing options from the following:
NOTE: For additional detail about the contents on the tabs use online help. Refer to the On-line Help procedure in the B.) Basic
Printing section in the User Guide (Print).

Paper/Output Tab

Selections include Job Type, Copies, Paper Size, Output Size,
Image Orientation, Mixed Orientation, Multiple Up, Output Color, 2
Sided Print, Output Destination, Paper Source, Paper Type
(Bypass Tray), or select Printer Status, Poster/Booklet, Print Area,
or Restore Defaults buttons.

Output Options

Select from Front Cover, Feed Cover from, Transparency
Separators, Job Offset, Stapling, or select Margin Shift or Restore
Defaults buttons.
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Graphics

Specify how you want to manipulate graphic images for your print
job. Select from the following options: Output Color, Print Mode,
Image Adjustment Mode, Image Types, Image Auto Correction, or
select the Image Settings, Color Balance, Profile Settings,
Detailed Settings, or Restore Defaults buttons.
For more information on how to set graphic options refer to section
C. Special Printing in the User Guide (Print).

Watermarks

Fonts
User Settings
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Specify watermark settings. Selections for watermarks include
First Page Only or In Background, Encircle, Text, Position, Angle,
or select the Restore Defaults button.
Use the TrueType Font control to select how TrueType Fonts will
be processed and printed.
The User Settings tab dialog provides options for you to save
frequently used print driver settings and then recall these settings
without having to configure again.
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Windows 2000 and Windows XP

Installing PostScript or PCL Print Driver

•

Obtain the Print Driver for your workstation's operating
system. Print drivers are available on a CD-ROM that
came with your Printer. They are also typically available for
downloading in self-extracting Zip file format from the
Internet at www.xerox.com.

•

Obtain the printer’s IP Address by printing a System
Settings List or contacting your System Administrator.

•

Check that the machine is physically connected to the
network or to your computer.

For detailed instructions on how to connect the machine to a
network, refer to the System Administrator’s Guide.

1

2
3
4

To begin the print driver installation select one of the following.
•

Windows 2000: from the Start menu, select Settings, and
then Printers.

•

Windows XP: from the Start menu, and then Printers and
Faxes.

In the Printers window select one of the following.
•

Windows 2000: double click Add Printer.

•

Windows XP: from Printer Tasks, select Add a printer.

When the Add Wizard displays, select Next. The Local or Network
Printer screen is displayed.
Select either Local Printer or Network Printer.
•

If Local printer is selected, deselect the “Automatically
detect and install my Plug and Play printer” check box.

•

If Network printer is selected, specify the target printer in
the “Connect to printer” dialog box.
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Prior to installing the AdobePS 4.4.Xor PCL 6/5e Version 4.1 print
driver perform the following.
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5
6
7
8
9

Select Next. The Select the Printer Port screen is displayed.
Select one of the following and then select Next.
•

Use the following port.

•

Create a new port.

Insert the CD-ROM in the CD-ROM drive.
When the Add Printer Wizard window displays Manufacturers and
Printers lists, select Have Disk… The Install From Disk screen is
displayed.
Enter the path for your driver files in the “Copy manufacturer’s files
from:” box.
NOTE: You can also use the Browse button to specify a folder in
the CD-ROM.

10
11
12
13
14
15
16
17
18
19
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Select the .INF file, then select Open.
When the Install From Disk screen is displayed, verify that the
path and file name are correct and select OK.
Select your printer model from the Printers list and select Next.
Enter the printer name, set whether you want to use it as your
default printer, and select Next.
Select Do not share this printer, and select Next
Select Yes to print a test page, then select Next.
Select Finish.
Verify that the test page prints at the printer then select Yes.
Confirm that the printer has been added in the Printers window.
Continue to the next page in order to configure the print driver to
complete the installation.
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Configuring the PostScript Print Driver on Windows 2000/XP
This section describes the following printer specific settings
included in the AdobePS 4.4.X Print Driver Properties and Printing
Preferences.
•

Print Driver Properties
Device Settings Tab > Installable Options
Configuration Tab

•

Printing Preferences
Advanced Options Dialog Box > Printer Features
Output Setting Tab
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Print Driver Properties

•

Installable Options in the Device Settings Tab

•

Configuration Tab
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Installable Options Settings
This describes Installable Options in the Device Settings tab.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.

1
2
3
4
5

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Device Settings tab.
Select the items you want to set in Installable Options.
Change the settings in the underlined menu that is displayed on
the right of the option.
When all setting changes are completed, select OK.

Settings
Memory

Specify the amount of printer memory.
•

Output Tray
Paper Detect by Tray
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The default setting is Normal 512MB

Specify whether Finisher is installed and the type.
Specify either Statement Paper Detection, or A5 Paper Detection.
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Configuration Tab Settings
This section describes the settings of the Configuration tab.

2
3
4

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Configuration tab.
Change the settings that you want to set.
When all setting changes are completed, select OK.

Specify Job Owner
Use Login Name

Use your Windows Login Name as the Job Owner Name. The Job
Owner Name becomes the “Login User Name\Host Name”.

Enter Owner Name (For
Administrator)

Select this if you want to specify a custom Job Owner Name,
which is used for all the printer icons.

Enter Owner Name (For
User)

Select this if you want to specify a custom Job Owner Name for
each Windows Login user.
NOTE: You can enter up to 31 alphanumeric characters for the
Login Name and the Owner Name. If you enter more than 31
characters for either name, only the first 31 characters are used.

Password

Enter the password for the Job Owner Name. The password can
consist of 4 to 12 digits. Each digit entered displays as an asterisk
(*).
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Job Type User Setting
Enter the User ID and password for the Job Type, which includes
Secure Print, Sample Print, and Delayed Print.
User ID

Enter the User ID for Print Type. The User ID can contain up to a
maximum of 24 alphanumeric characters.

Password

Enter the password for the Job Type. You can enter up to 4 digits.
Each digit entered displays as an asterisk (*).

Printing Preferences

2–50

•

Sections specific to the printer in Printer Features of the
Advanced Options Dialog Box

•

Output Settings Tab
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Advanced Options Dialog Box Settings
This section describes the settings of the Advanced Options
dialog box displayed when selecting Advanced in the Layout tab.

2
3
4
5

Select the printer icon in the Printers window, then select Printing
Preferences from the File menu.
On the Layout tab, select Advanced....
Select the items in Printer Features.
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1

Change the settings on the menu displayed to the right.
When all setting changes are completed, select OK.
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Printer Features Settings
Output Tray

Set the destination for the output.
•

The items that can be selected vary according to whether
the Center Tray or Finisher Tray has been installed.

Job Offset

Shifting the output positions of adjacent jobs (print command) or
copies (sets) is called Job Offset. The positions of adjacent jobs or
sets of copies are shifted to the front and the next job or set of
copies is shifted to the back.

Transparency Separators

Specify whether to use transparency separators and the source of
the separators.
Select Auto for three paper source to automatically feed from the
paper tray with paper of the same size and in the same orientation
as the transparencies.
NOTE: When using Transparency Separators, be sure to load
paper of the same size and in the same orientation as
transparencies into the paper tray.
NOTE: The Transparency Separators function cannot be used in
the following situations:

Bypass Feed Orientation
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•

When anything other than Manual feed is selected for
Paper source in the Paper/Quality tab.

•

When anything other than Transparency is selected for
Media type in the Paper/Quality tab.

•

When anything other than Center Output Tray is selected
for Output Destination in the Advanced Options tab.

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape. When you set the long side of the
paper in the bypass tray, select Portrait.
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Print Mode

Specify whether to give priority to the print speed or the image
quality. The printer/copier is capable of printing at three different
resolutions:
High Speed: 600 x 600
Standard: 1200 x 600
High Quality: 1200 x 1200
To change resolution settings, use the Print Mode selections.
NOTE: The Image Enhancement feature is not available when
Standard or High Quality is selected.

RGB Color Correction

Specify your output printing options select either Color or Black.
Specify the coloration of the RBG Color Correction.
Normal: This setting is optimized for printing documents that
contain text and graphics, such as business documents.
Photo: This setting is optimized for printing photos or images with
gradations. Select this setting when printing images in RBG.
Web Pages: This setting is optimized for printing web pages.
Presentation: This setting is optimized for printing the color
documents vividly, such as presentation documents.

RGB Gamma Correction

Specify the brightness of the documents. The higher the value, the
darker the print becomes.

Screen

You can adjust the image quality. Select Gradation to print photos
and gradations clearly. Select Fineness to print the colors in
illustrations, tables, or graphs evenly.

Image Enhancement

Specify whether to use the Image Enhancement function.
Selecting On, smooths out the boundaries between black and
white when printing. This reduces jagged edges, thereby
artificially increasing the resolution of the image. When printing an
image (bitmap) composed of coarse halftone dots, smooth color
gradation is impossible in certain situations. In this case, select
Off.
NOTE: The Image Enhancement feature is available only when
Print Mode is set to High Speed.
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Output Color
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Draft Mode

Specify whether to reduce the amount of toner used when printing
drafts. When you select On, the overall printed color becomes
lighter. This is best for printing documents when print quality is not
necessary.

Gray Guaranteed

Select On to print grays and black within documents in black toner
only. This prevents neutral grays from exhibiting any kind of color
shading or misregistration. This feature does not apply to images
of the documents.
NOTE: For documents containing sweeps/gradients that include
gray, it may be preferable to set this feature to Off.

Stapling

Select whether to staple printed documents as well as the position
of the staple.
•

You can staple 2 to 50 sheets.

•

You can only staple when Finisher Tray is selected for
Output Destination in the Advanced Options tab.

•

You cannot use staples when Job Offset is selected.

Custom Paper Image
Rotation

Select whether to correct the paper orientation when printing on
custom paper. When printing on custom paper, select On to
correct the orientation rotated at 90 degrees.

Substitute Tray

Specify what action to take when the paper size called for is not
loaded in the machine.
Use Printer Settings: The settings can be confirmed on the
printer control panel.
Display message: Display paper supply messages on the printer
control panel. Printer will be unavailable until paper is supplied.
Use Nearest Size (With Zoom): Select the nearest paper size.
Automatically reduces or enlarges images for printing, as
necessary.
Use Nearest Size (No Zoom): Select the nearest paper size
available and prints in equal size.
Use Larger Size (With Zoom): Print in equal size on paper larger
than the original. Automatically reduces images for printing, as
necessary.
Use Larger Size (No Zoom): Print on paper larger than the
original.

2–54

USER GUIDE (PRINT)

Output Setting Tab Settings
This section describes the settings in the Output Settings tab.

2
3
4

Select the printer icon in the Printers window, then select Printing
Preferences from the File menu.
Select the Output Settings tab.
Change the settings that you want to set.
When all setting changes are completed, select OK.

Job Type
Job Type

You can specify the print function from among Secure Print,
Sample Print, and Delayed Print.
Secure Print: A function that temporarily stores print jobs in the
printer, and prints the job when instructed from the printer control
panel.
•

If you want to output secure prints, set the User ID and
password for Print Type in the Configuration tab.

Sample Print: A function that outputs only 1 set when multiple
sets are specified. If the job is as specified, the remaining sets are
printed.
Delayed Print: A function that temporarily stores print jobs in the
printer, and prints them at a scheduled time.
Normal Print

Select when you do not want to output secure prints, sample
prints, or delayed prints.
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Secure Print

Select when you want to output secure prints.

Sample Print

Select when you want to output sample prints.
NOTE: The Collated setting must be selected in the Page Setup
tab when using Job Type.

Delayed Print

Select when you want to output delayed prints.

User ID

Displays the User ID for Job Type. The User ID displayed is the
User ID specified on the Configuration tab. This option can only be
selected when the setting on the Configuration tab has been
completed. This is a display-only item and cannot be changed in
User ID.

Password

Displays the Job Type password specified in the Configuration
tab. Each digit entered is displayed as an asterisk (*). This option
can only be selected when the setting on the Configuration tab
has been completed. This is a display-only item and cannot be
changed in Password.

Retrieve Document Name

Select the method of specifying the document name. If you have
selected Auto Retrieve, the valid document name can be up to 24
alphanumeric characters.

Document Name

Start Print Time

When “Enter Document Name” is selected in the Stored
Document Name list, you can specify a document name with a
maximum of 24 alphanumeric characters.
Set the time that you want Delayed Print to be carried out. Place
the cursor in the hour or minute box and press the up or down
triangle to specify the starting time. You can also set the time by
entering the time directly into the boxes.
•

2–56

The default setting is 00:00
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Configuring the PCL Print Driver on Windows 2000/XP
This section describes the following printer specific settings
included in the PCL 6/5e Version 4.1 Print Driver Properties and
Printing Preferences.
•

Print Driver Properties
Configuration Tab
Printer Tab

•

Printing Defaults
Advanced Tab
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Print Driver Properties

•

Configuration Tab

•

Printer Tab
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Configuration Tab Settings
This describes Print Features in the Configuration tab.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.

1
2
3
4
5
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Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Configuration tab.
Select the items in Print Features that you want to set.
Change the settings in the list box that is displayed below the Print
Features list.
When all setting changes are completed, select OK.
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Print Features
EMF Spooling

Print Page Mode
Specify Job Owner

Select On to specify the spool format of the print data in the hard
drive as RAW format. As it takes time to convert print data, the
processing time is extended.
Select Print Page Mode to On to enhance printer performance
with large complex jobs.
Use this feature to specify a job owner.
Use Login Name: Use your Windows Login Name as the Job
Owner Name. The Job Owner Name becomes the “Login User
Name\Host Name”.

Enter Owner Name (For User): Select this if you want to specify
a custom Job Owner Name for each Windows Login user.
NOTE: You can enter up to 31 alphanumeric characters for the
Login Name and the Owner Name. If you enter more than 31
characters for either name, only the first 31 characters are used.
Password: Enter the password for the Job Owner Name. The
password can consist of 4 to 12 digits. Each digit entered displays
as an asterisk (*).
Bypass Feed Orientation

Substitute Tray

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape. When you set the long side of the
paper in the bypass tray, select Portrait.
Specify what action to take when the paper size called for is not
loaded in the machine.
Use Printer Settings: The settings can be confirmed on the
printer control panel.
Display message: Display paper supply messages on the printer
control panel. Printer will be unavailable until paper is supplied.
Use Nearest Size (With Zoom): Select the nearest paper size.
Automatically reduces or enlarges images for printing, as
necessary.
Use Nearest Size (No Zoom): Select the nearest paper size
available and prints in equal size.
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Enter Owner Name (For Administrator): Select this if you want
to specify a custom Job Owner Name, which is used for all the
printer icons.
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Printer Tab Settings
This describes Printer tab.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.

1
2
3
4
Finisher
A5 & Statement Paper
Detection
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Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Printer tab.
Select the Auto Configuration button or select the items
manually in Change Setting For: that you want to set.
When all setting changes are completed, select OK.
An optional output tray with stapling function that can be added to
the side of the printer.
Optional output functions to enable Trays 1 - 4 to detect certain
paper sizes.
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Printing Defaults
This describes the Printing Defaults on the Advanced tab.
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NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.
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1
2
3

4

Select the printer icon in the Printers window, then select
Properties from the File menu.
Select the Advanced tab.
Select the Printing Defaults button to view or change the
document default properties for all users of the selected printer.
Select your changes on the following tabs:
•

Paper/Output

•

Output Options

•

Graphics

•

Watermarks

•

Fonts

•

User Settings

•

About

When all setting changes are completed, select OK.
Specify your printing options from the following:
For additional detail about the contents on the tabs use on-line
help. Refer to the On-line Help procedure in the B. Basic Printing
section in the User Guide (Print).

Paper/Output Tab
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Selections include Job Type, Copies, Paper Size, Output Size,
Image Orientation, Mixed Orientation, Multiple Up, Output Color, 2
Sided Print, Output Destination, Paper Source, Paper Type
(Bypass Tray), or select Printer Status, Poster/Booklet, Print Area,
or Restore Defaults buttons.
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Output Options

Graphics

Select from Front Cover, Feed Cover from, Transparency
Separators, Job Offset, Stapling, or select Margin Shift Restore
Defaults buttons.
Specify how you want to manipulate graphic images for your print
job. Select from the following options: Output Color, Print Mode,
Image Adjustment Mode, Image Types, Image Auto Correction, or
select the Image Settings, Color Balance, Profile Settings,
Detailed Settings, or Restore Defaults buttons.
For more information on how to set graphic options refer to section
C.) Special Printing in the User Guide (Print).
Specify watermark settings. Selections for watermarks include
First Page Only or In Background, Encircle, Text, Position, Angle,
or select the Restore Defaults button.

Fonts

Use the TrueType Font control to select how TrueType Fonts will
be processed and printed.

User Settings

The User Settings tab provides options for you to save frequently
used print driver settings and then recall these settings without
having to configure again.

About

The About tab displays the name, version, and copyright
information of the print driver.
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Watermarks

USER GUIDE (PRINT)

Macintosh

Installing PostScript Print Driver
There are three steps to install the print driver:
•

Use the installer CD-ROM that you received with the
printer to install the printer to the Macintosh.

•

Configure the PPD File.

•

Configure the print driver.

Prior to installing the AdobePS 4.4.X print driver perform the
following.

1
2
3
4
5
6
7
8
9
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Insert the CD-ROM in the CD-ROM drive.
Copy the PPD (PostScript Printer Description) file to the System
Folder\Extensions\Printer Descriptions folder on your
workstation.
Locate the Adobe PostScript Print Driver file.
Double click the Adobe PS Installer icon. The Introduction screen
is displayed.
Select Continue on the Introduction screen.
On the Licensing screen, select Accept.
Review the Read Me file then select Continue.
Verify the location for the print driver file and select Install.
When the installation completes, select Restart to reboot the
workstation.
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Configure the PPD File

11
12
13
14
15
16
17

In the Apple Chooser, select the Adobe Postscript or Apple
LaserWriter printer.
Select the appropriate AppleTalk zone (if applicable) and the
printer name.
Select Create (for initial installation) or Setup (for all subsequent
installations) and select the PPD file for the printer. The PPD
screen is displayed.
On the PPD screen, select Select PPD.
If it is not already selected, highlight the Printer’s PPD in the list
and select Select.
Select OK.
Confirm that the printer has been added.
Continue to the next page in order to configure the print driver to
complete the installation.
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Setting the Print Driver Properties on Macintosh
This section describes printer specific settings included in the print
driver properties.
NOTE: Typically, Installable Options is automatically set according
to the 1-directional communications with the printer. It is not
necessary to change the setting.
•

Installable Options on the Option menu

•

Printer Specific Options

Configure Settings
This describes Installable Options.
NOTE: In order to print correctly, it is necessary to make
appropriate settings in this tab.

1
2
3

Select the printer using the Chooser and select Setup. The
Current Printer Description File (PPD) Selected screen is
displayed.
Select Configure on the Current Printer File (PPD) Selected
screen. The Installable Options list is displayed.
Set the option menu items in Installable Options. Select OK.

Settings
Memory

Specify the amount of printer memory.
•

Output Tray

Set the destination for the output.
•

Paper Detect by Tray
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The default setting is Standard 512MB
The items that can be selected vary according to whether
Finisher has been installed.

Specify either Statement Paper Detection, or A5 Paper Detection.
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Printer Specific Options Settings
This describes Printer Specific Options, used to set the print
driver.

On the File menu of the application, select Print.
Select Printer Specific Options.
Select the features you want to set.

Settings
This section describes the settings of the Printer Specific Options
list.
Output Tray

Set the destination for the output.
•

The items that can be selected vary according to whether
the Side Output Tray or Finisher Tray has been installed.

Job Offset

Shifting the output positions of adjacent jobs (print command) or
copies (sets) is called Job Offset. The positions of adjacent jobs or
sets of copies are shifted to the front and the next job or set of
copies is shifted to the back.

Collated

Selects whether to collate a multi-page file per set when they are
printed.
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1
2
3
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Transparency Separators

Specify whether to use transparency separators and the source of
the separators.
Select Auto for three paper source to automatically feed from the
paper tray with paper of the same size and in the same orientation
as the transparencies.
NOTE: When using Transparency Separators, be sure to load
paper of the same size and in the same orientation as
transparencies into the paper tray.
NOTE: The Transparency Separators function cannot be used in
the following situations:

Bypass Feed Orientation

Paper Type (Bypass Tray)
Print Mode

•

When anything other than Manual feed is selected for
Paper source in the Paper/Quality tab.

•

When anything other than Transparency is selected for
Media type in the Paper/Quality tab.

•

When anything other than Center Output Tray is selected
for Output Destination in the Advanced Options tab.

•

When print on both sides is selected.

Specify the paper orientation when printing from the bypass tray.
When you set the short side of the paper in the bypass tray feed
direction, select Landscape. When you set the long side of the
paper in the bypass tray, select Portrait.
Select the type of the paper set in the bypass tray.
Specify whether to give priority to the print speed or the image
quality. The printer/copier is capable of printing at three different
resolutions:
High Speed: 600 x 600
Standard: 1200 x 600
High Quality: 1200 x 1200
To change resolution settings, use the Print Mode selections.
NOTE: The Image Enhancement feature is not available when
Standard or High Quality is selected.

Output Color
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Specify your output printing options select either Color or Black.
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RGB Color Correction

Specify the coloration of the RGB Color Correction.
Normal: This setting is optimized for printing documents that
contain text and graphics, such as business documents.
Photo: This setting is optimized for printing photos or images with
gradations. Select this setting when printing images in RGB.
Web Pages: This setting is optimized for printing web pages.

RGB Gamma Correction

Specify the brightness of the documents. The higher the value, the
darker the print becomes.

Screen

You can adjust the image quality. Select Gradation to print photos
and gradations clearly. Select Fineness to print the colors in
illustrations, tables, or graphs evenly.

Image Enhancement

Specify whether to use the Image Enhancement function.
Selecting On, smooths out the boundaries between black and
white when printing. This reduces jagged edges, thereby
artificially increasing the resolution of the image. When printing an
image (bitmap) composed of coarse halftone dots, smooth color
gradation is impossible in certain situations. In this case, select
Off.
NOTE: The Image Enhancement feature is available only when
Print Mode is set to High Speed.

Draft Mode

Specify whether to reduce the amount of toner used when printing
drafts. When you select On, the overall printed color becomes
lighter. This is best for printing documents when print quality is not
necessary.

Gray Guaranteed

Select On to print grays and black within documents in black toner
only. This prevents neutral grays from exhibiting any kind of color
shading or misregistration. This feature does not apply to images
of the documents.
NOTE: For documents containing sweeps/gradients that include
gray, it may be preferable to set this feature to Off.

Stapling

Select whether to staple printed documents as well as the position
of the staple.
•

You can staple 2 to 30 sheets.

•

You can only staple when Finisher Tray is selected for
Output Destination in the Advanced Options tab.

•

You cannot use staples when Job Offset is selected.
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Presentation: This setting is optimized for printing the color
documents vividly, such as presentation documents.
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B.

Basic Printing

Paper

For more information on how to load paper, refer to the User
Guide (Copier).

Differences From Copying
Tray 5 (Bypass)

When using Tray 5 (Bypass), there is a restriction on the
orientation of loading paper.
When printing with Tray 5 (Bypass), be sure to select Tray 5
(Bypass) from the Paper Source menu on the Tray/Output tab,
and then select the correct paper type from the Paper Tray
(Bypass) menu on the print driver screen.
Refer to On-line Help of the print driver for details on printing
special papers like transparencies.
For details on loading paper in Tray 5 (Bypass), refer to the User
Guide (Copier).

Caution for Printing

Automatic Tray Switching

If the paper size or type used for printing is different from the
selection on the print driver, or if the paper is loaded in an
unsuitable paper tray, it may cause paper to jam.
To enable the Auto Tray Switch feature, Auto must be selected
from the Paper Source menu on the Tray/Output tab.
NOTE: The Auto Tray Switch feature is displayed as Disable Auto
Tray Switch in the Common Menu and Internet Services.

Outputting Paper

To use the Job Offset feature you must first configure the setting
on the Configuration tab of the print driver.
Refer to the On-line Help of the print driver for details.
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This section identifies differences in paper usage as compared to
paper usage when copying. Other than these, there are no
differences between using paper for copying and printing.
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Prior to Printing
In order to print from your computer, you must first install a print
driver. Print drivers are software that convert print data or
instructions from the computer into data that can be interpreted by
the printer.

Printing Procedure
The printing procedure will differ according to the application
program used. For details, refer to your application program
manual.

I

1
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Select Print from the application program File menu. The Print
screen is displayed.
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Select the Printer and then select Properties. The Printer
Properties screen is displayed.

3

Select the desired printing options for your print job.

4

Select OK.
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2
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Setting Printing Features
Typically, printing features are set on the printer properties dialog
box that is displayed when entering either printing from the
application program or selecting Properties from the File menu on
the printer icon.
From the Properties screen, select the desired features in each
tab.
NOTE: Refer to the On-line Help of the printer driver for details on
the options of the printer driver and how to select the options.
For more information on how to use On-line Help, refer to Using
On-line Help, on the next page.
NOTE:

2–74

•

For Windows 95/98/Me, select Properties.

•

For Windows NT 4.0, select options from the tabs that are
displayed by selecting Document Defaults and
Properties from the File menu.

•

For Windows 2000 and Windows XP, select options from
the tabs that are displayed by selecting Printing
Preferences and Properties from the File menu.

•

For Windows 98, Windows Me, Windows 2000 and
Windows XP, options are also displayed on the Color
Management tab.

•

For complete settings details, refer to the Driver
Configuration information at the beginning of this chapter.
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Using On Line Help
On-line Help explains the print driver options and the basic
printing process.

View Details of Each Option
On the active properties dialog box of the print driver, select the
“question mark” button on the top right corner of the window, and
after the cursor has changed to a “question mark”, select the
desired option.

On the active properties dialog box of the print driver, select the
Help button on the bottom right corner of the window to display a
Help window, which explains the currently displayed screen.
Select the Contents button at the top left corner of the Help
window to display the contents of the printing process.
Double-clicking the title of the desired process will display the
explanation.
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View Basic Printing Process
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Switching Printer Off-line
When the printer is switched off-line, it cannot receive data.
Receiving data will be interrupted and will not be printed.

1
2
3
4
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On the control panel, press the Machine Status button. The
Machine Status screen is displayed.
Select Print Mode located on the Machine Status tab. The Print
Mode screen is displayed.
Select Off-line.
Select Close.
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Cancel Print/Check Print Job Status

Cancel Print from the Workstation

From the Start menu, select Settings and then select Printers.
Open the icon of the printer model.
In the window displayed, select any document name and then
press Delete on the keyboard.

Canceling a Print Job Using Internet Services
You can cancel printing from your workstation using Internet
Services via a browser.
For more information on Internet Services, refer to the Internet
Services section D in the User Guide (Print).

Canceling a Print Job From the Printer
There are three options available for canceling a print job at the
machine. You can cancel a print job that is in process, one that is
currently being printed or one that is stored for printing at a later
time.
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1
2
3
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Canceling a Print Job in Process
•

Either press the Stop button on the control panel or select
Stop on the following screen.
•

The job currently being processed will be discontinued.

Canceling a Print Job During Print

1
2

Either press the Stop button on the control panel or select Stop.
The job currently being processed will be discontinued.
To stop printing, either press the Stop button on the control panel
or select Stop on the following screen.
NOTE: The page that is currently printing will be printed.
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Canceling Jobs Stored in the Printer
You can interrupt the printer from receiving data and empty the
buffer using the procedure below.

2
3
4
5

On the control panel, press Job Status. The Job Status screen is
displayed.
On the Job Status screen, select Current/Pending Jobs. A list of
jobs in process or waiting is displayed.
Select the job that you want to delete. The job status is displayed.
Select Stop. The job processing will be discontinued.
Select Close.
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C.

Special Printing

Specifying Output Color for Printing in a PCL Driver
You can specify the output color for printing.
From the Output Color menu of either the Paper/Output or
Graphics tab, select Black or Auto.

Printing with Black
To print in black and white, select Black from the Output Color
menu.

Print Mode
Specify whether to give priority to the print speed or the image
quality. The printer/copier is capable of printing at three different
resolutions:
High Speed: 600 x 600
Standard: 1200 x 600
High Quality: 1200 x 1200
To change resolution settings, use the Print Mode selections.
NOTE: The Image Enhancement feature is not available when
Standard or High Quality is selected.
Options
High Speed
Standard
High Quality

Contents
Prints faster but with a loss of image
quality.
The average mode of High Speed and
High Quality.
Prints with better quality but slower

NOTE: If printing is slow even when High Speed has been
selected, try setting Print Page Mode on the Configuration tab to
On. The printing time may be shortened.
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Image Adjustment Mode

Options

Contents

Recommended

A unique system of our company to
adjust image quality.

The possible feature combinations of Print Mode and Output Color
and other options of the Graphics tab are as follows:
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NOTE: When Black has been selected for Output Color, only
Recommended can be selected for Image Adjustment.
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Black & High Speed
The possible feature combinations when Black for Output Color
and High Speed for Print Mode have been selected:

Graphics Options
Image Settings

Color Balance

Profile Settings

Detailed
Settings:

Brightness

Recommended

Available

Chroma

NA

Contrast

Available

Black

Available

Cyan

NA

Magenta

NA

Yellow

NA

Color
Correction
Temperature/
Gamma

Available

ICC Profile

Available

Text

Change All
Colors to
Black

Available

Graphic

Change All
Colors to
Black

Available

Thicken Fine
Lines

Available

Paint Only
Enclosed
Areas

Available

Image
Compression

Available

Smoothing

Available

High Speed
Image
Processing

Available

Image
Enhancement

Available

Draft Mode

Available

Resolution

Available

Photo

All

2–82

Image
Adjustment
Mode
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Black & Standard
The possible feature combinations when Black for Output Color
and Standard for Print Mode have been selected:

Image Settings

Color Balance

Profile Settings

Detailed
Settings:

Image
Adjustment
Mode
Brightness

Recommended

Available

Chroma

NA

Contrast

Available

Black

Available

Cyan

NA

Magenta

NA

Yellow

NA

Color
Correction
Temperature/
Gamma

Available

ICC Profile

Available

Text

Change All
Colors to
Black

Available

Graphic

Change All
Colors to
Black

Available

Thicken Fine
Lines

Available

Paint Only
Enclosed
Areas

Available

Image
Compression

Available

Smoothing

Available

High Speed
Image
Processing

Available

Photo

All

Image
Enhancement

NA

Draft Mode

Available

Resolution

Available
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Graphics Options
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Black & High Quality
The possible feature combinations when Black for Output Color
and High Quality for Print Mode have been selected:

Graphics Options
Image Settings

Color Balance

Profile Settings

Detailed
Settings:

Brightness

Recommended

Available

Chroma

NA

Contrast

Available

Black

Available

Cyan

X

Magenta

X

Yellow

X

Color
Correction
Temperature/
Gamma

Available

ICC Profile

Available

Text

Change All
Colors to
Black

Available

GraphIC

Change All
Colors to
Black

Available

Thicken Fine
Lines

Available

Paint Only
Enclosed
Areas

Available

Image
Compression

Available

Smoothing

Available

High Speed
Image
Processing

Available

Photo

All
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Image
Adjustment
Mode

Image
Enhancement

NA

Draft Mode

Available

Resolution

Available
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1
2
3
4

Select Print from the File menu.
Check Printer, and then select Properties.
Select the Graphics tab.
Select Black from the Output Color drop-down list.

5
6

Select the mode from the Print Mode drop-down list box.
Select OK.

Printing with Auto
Auto

Before printing, the printer can detect the colors on every
document page, and then switch automatically to Color when
colors other than black and white are used, and to Black when
only black and white are used. Select Auto from the Output Color
menu.

Output Color Recognition

When this feature is checked, pages with only some degree of
unevenness in color will be detected as black and white. When the
box has not been checked, only pages with even degree of color
will be detected as black and white.
You can also configure the Print Mode, Image Adjustment Mode
and Image Auto Correction settings. However, pages detected as
black and white will be printed with the settings of Black mode.
Display the Graphics tab to configure these settings.
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NOTE: You can also select from Output Color on the Paper/
Output tab.
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Print Mode
Specify whether to give priority to the print speed or the image
quality. The printer/copier is capable of printing at three different
resolutions:
High Speed: 600 x 600
Standard: 1200 x 600
High Quality: 1200 x 1200
To change resolution settings, use the Print Mode selections.
NOTE: The Image Enhancement feature is not available when
Standard or High Quality is selected.
Options
High Speed
Standard
High Quality

Contents
Prints faster but with a loss of image
quality.
The average mode of High Speed and
High Quality.
Prints with better quality but slower

NOTE: If printing is slow even when High Speed has been
selected, try setting Print Page Mode on the Configuration tab to
On. The printing time may be shortened.
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Image Adjustment Mode
The available options in Image Adjustment mode are:
•

Recommended

•

ICM (System)

NOTE: The ICM (System) setting is not available for Windows NT
4.0 Operating System.
CMS (Application)

•

Complimentary Color Conversion

When Recommended has been selected, select the image type
from the Image Types list box.

Options
Normal
Photo

Contents
Prints documents with a mixture of
texts, graphs and photos, fast.
Reproduces photos and gradation
more accurately. Suitable for printing
of images in RGB.

Presentation

Adjusts colors vividly for printing.
Suitable for presentation materials.

Web Pages

Effectively reproduces screen displays
like web pages.

2–87

USER GUIDE (PRINT)

Recommended

•
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ICM (System)

Changes colors using the ICM feature of Windows 98, Windows
Me, Windows 2000, and Windows XP.
When ICM (System) has been selected, select the way of
converting colors from the Indent list box.
NOTE: Prior to using the ICC profile of this machine, register it on
the Color Management tab of the print driver.

Options
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Contents

Saturation

Converts colors to improve the
reproduction of graphics in
presentation materials.

Perceptual

Converts colors to improve the
reproduction of images like photos.

Colorimetric

Reproduces suitably only colors that
can be reproduced by the printer and
converts others not within the
reproduction range to other colors.

CMS (Application)

The print driver does not convert any colors. When printing from
an application program with its own Color Management System
(CSM), the print driver will receive instruction on color data
converted according to the printer characteristics. In this case,
select this item to prevent double color conversion by the print
driver.

Complementary Color
Conversion

Selecting this will enable the Auto Correction for you to select an
option.
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Image Auto Correction
When the document to be printed includes photo images, you can
correct the image quality according to the special characteristics
of the photo images. You can perform automatic correction
according to the characteristics of the specified image type.
NOTE: Image Auto Correction cannot be selected when ICM
(System) or CMS (Application) has been selected for Image
Adjustment Mode.

Options

Contents

Normal

Corrects imbalances in photo images
like too bright or dark, or too greyish.
Images with insufficient contrast and
saturation will be automatically
corrected.

Portrait

Automatically corrects the brightness,
contrast and saturation suitable for
images of people.

Landscape

Automatically corrects the brightness,
contrast and saturation suitable for
images of scenery.

Map

Automatically corrects maps and onsite photos to reproduce the text and
detailed portions clearly.

NOTE: ICM (System) only will be display in Windows 98, Windows
Me, Windows 2000, and Windows XP.
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The possible feature combinations of Print Mode, Image
Adjustment Mode and other options of the Graphics tab are as
follows:
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Auto & High Speed
The possible feature combinations when Auto for Output Color
and High Speed for Print Mode have been selected:

Recommended

ICM Adj.
(System)

CMS Adj.
(Application)

Complementary
Color
Conversion

Brightness

Available

NA

NA

Available

Chroma

Available

NA

NA

Available

Contrast

Available

NA

NA

Available

Black

Available

Available

Available

Available

Cyan

Available

Available

Available

Available

Magenta

Available

Available

Available

Available

Yellow

Available

Available

Available

Available

Color
Temperature/
Gamma

Available

NA

NA

Available

ICC Profile

Available

NA

NA

Available

Text

Change All
Colors to
Black

NA

NA

NA

NA

Graphic

Change All
Colors to
Black

NA

NA

NA

NA

Thicken Fine
Lines

Available

Available

Available

Available

Paint Only
Enclosed
Areas

Available

Available

Available

Available

Image
Compression

Available

Available

Available

Available

Smoothing

Available

Available

Available

Available

High Speed
Image
Processing

Available

Available

Available

Available

Image
Enhancement

Available

Available

Available

Available

Draft Mode

Available

Available

Available

Available

Resolution

Available

Available

Available

Available

Graphics Options

Image Settings

Color Balance

Profile Settings

Detailed
Settings:

Photo

All
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Adjustment
Mode
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Auto & Standard

Recommended

ICM Adj.
(System)

CMS Adj.
(Application)

Complementary
Color
Conversion

Brightness

Available

NA

NA

Available

Chroma

Available

NA

NA

Available

Contrast

Available

NA

NA

Available

Black

Available

Available

Available

Available

Cyan

Available

Available

Available

Available

Magenta

Available

Available

Available

Available

Yellow

Available

Available

Available

Available

Color
Temperature/
Gamma

Available

NA

NA

Available

ICC Profile

Available

NA

NA

Available

Text

Change All
Colors to
Black

NA

NA

NA

NA

Graphic

Change All
Colors to
Black

NA

NA

NA

NA

Thicken Fine
Lines

Available

Available

Available

Available

Paint Only
Enclosed
Areas

Available

Available

Available

Available

Image
Compression

Available

Available

Available

Available

Smoothing

Available

Available

Available

Available

High Speed
Image
Processing

Available

Available

Available

Available

NA

NA

NA

NA

Draft Mode

Available

Available

Available

Available

Resolution

Available

Available

Available

Available

Graphics Options

Image Settings

Color Balance

Profile Settings

Detailed
Settings:

Photo

All

Image
Adjustment
Mode

Image
Enhancement
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The possible feature combinations when Auto for Output Color
and Standard for Print Mode have been selected:
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Auto & High Quality
The possible feature combinations when Auto for Output Color
and High Quality for Print Mode have been selected:

Recommended

ICM Adj.
(System)

CMS Adj.
(Application)

Complementary
Color
Conversion

Brightness

Available

NA

NA

Available

Chroma

Available

NA

NA

Available

Contrast

Available

NA

NA

Available

Black

Available

Available

Available

Available

Cyan

Available

Available

Available

Available

Magenta

Available

Available

Available

Available

Yellow

Available

Available

Available

Available

Color
Temperature/
Gamma

Available

NA

NA

Available

ICC Profile

Available

NA

NA

Available

Text

Change All
Colors to
Black

NA

NA

NA

NA

GraphIC

Change All
Colors to
Black

NA

NA

NA

NA

Thicken Fine
Lines

Available

Available

Available

Available

Paint Only
Enclosed
Areas

Available

Available

Available

Available

Image
Compression

Available

Available

Available

Available

Smoothing

Available

Available

Available

Available

High Speed
Image
Processing

Available

Available

Available

Available

NA

NA

NA

NA

Draft Mode

Available

Available

Available

Available

Resolution

Available

Available

Available

Available

Graphics Options

Image Settings

Color Balance

Profile Settings

Detailed
Settings:

Photo

All
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Image
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Printing with Auto
This section describes the possible feature combinations when
Auto for Output Color and High Speed for Print Mode have been
selected.

Select Print from the File menu.
Check Printer and then select Properties.
Select the Graphics tab.
Select Auto from the Output Color drop-down list.
NOTE: You can also select from Output Color on the Paper/
Output tab.

5
6
7

Select the mode from the Print Mode drop-down list.
Select the mode from the Image Adjustment Mode drop-down list.
When Recommended has been selected, select the image type
from the Image Type list.
When ICM (System) has been selected, select the way of
converting colors from the Indent list.

8

Select OK.
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Adjusting Color for Printing
This section explains how to configure detailed color settings for
printing. These settings are configured on the Graphics tab. There
are four tabs on the Graphics tab. The options are as follows:
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Options

Contents

Image Settings

Adjusts the brightness, chroma, and
contrast of the whole document or of
each of the elements like text, graphic,
and photos.

Color Balance

Fine-tunes the toner density of black,
cyan, magenta, and yellow. Can be
set in low, medium, or high density.

Profile Settings

Configures settings like color
temperature/gamma correction and
ICC profile that match the
characteristics of devices (like monitor
and scanner) in order to reproduce
document image faithfully.

Detailed Settings

Adjusts the detailed image quality
settings of the whole document or
each of the elements like text, graphic,
and photos.
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Adjusting Image Settings (Brightness/Chroma/Contrast)
The brightness/chroma/contrast of the whole document or of each
of the elements like text, graphic, and photos can be adjusted.
You can adjust the brightness/chroma/contrast within the range of
-100 to 100 in units of 1. When adjusting for each of the elements
within the page will be detected automatically and will be set to the
appropriate value respectively.

Brightness

Contents
Expresses the degree of lightness/
darkness of color. The higher the
brightness, the closer the color is to
white.

Chroma

Expresses the degree of vividness of
color. The higher the chroma, the
more vivid is the color.

Contrast

Expresses the degree of change of
lightness/darkness/ from white to
black. The higher the contrast, the
more sudden is the change of degree.

Display the Image Settings tab to adjust these settings.
NOTE: When Output Color of the Graphics tab has been set to
Black, the chroma setting cannot be adjusted regardless of the
Print Mode setting.
NOTE: When Image Adjustment Mode of the Graphics tab has
been set to ICM (System) or CMS (Application), the brightness/
chroma/contrast setting cannot be adjusted. ICM (System) will
only be displayed in Windows 98, Windows Me, Windows 2000,
and Windows XP.
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1
2
3

Select Print from the File menu.
Check Printer, and then select Properties.
Select the Graphics tab and then Image Settings.
•

4
5
6

The Graphics tab will be opened with the Image Setting
tab displayed.

Select either Apply to All Elements or Apply to Selected
Element.
When Apply to Selected Element has been selected, select the
element from the list box on the right.
Adjusts the settings of brightness, chroma, and contrast.
You can either enter the value or use the slider bar to adjust
the value to be within the range of -100 to 100, in units of 1.

7
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Select OK.
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Adjusting Color Balance
You can adjust the toner density of Cyan, Magenta, Yellow, Black
(CMYK) for printing. Each color can be adjusted to low/medium/
high density and in seven levels each within the range of -3 to 3.
Display the Color Balance tab to adjust these settings.
NOTE: When Output Color of the Graphics tab has been
selected as Black, only black can be adjusted here.

Select Print from the File menu.
Check Printer, and then select Properties.
Select the Graphics tab and then the Color Balance button.
•

4
5
6

Check the Adjust Color Balance check box.
Select the color to be adjusted from the list box below.
Adjust the density.
•

7

The Graphics tab will be opened with the Color Balance
tab displayed.

Use the up and down arrow buttons located below the
graphs of low/medium/high density to adjust the settings.

Select OK.
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Adjusting Profile Settings
You can correct profile settings to match the characteristics of
devices (like monitor and scanner) in order to reproduce graphic
images consistently for printing. There are two types of profile
settings:
•

Color Temperature/Gamma Correction

•

ICC Profile

For Color Temperature/Gamma Correction, you can specify the
appropriate Color Temperature and Gamma Correction for all
elements of a document.
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Options

Contents

Color Temperature

Changes the color tone of all the
document elements to match the
setting of the monitor in use. Select
the option closest to the
characteristics of the monitor. Options
available: 5000 K (D50), 6500 K
(D65), 9300 K.

Gamma Correction

Changes the brightness of all the
document elements. Options
available: 1.0, 1.4, 1.8, 2.2, 2.6
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For Profile Settings, you can specify the ICC profile for Monitor
and Input Image. ICC profile is a file that describes the
characteristic about the device color. The selectable ICC profile
applies only to the monitor and RBG scanner.

Contents

Monitor

Specifies the ICC profile that is
applicable to text, drawing, table and
graph. Options available: Off and
Browse.... Usually, select the ICC
profile of the monitor in use.

Input Image

IUCC profile appropriate to the image
data. Options available: Off, Same as
Monitor, and Browse.... Usually,
select the ICC profile of the RBG
scanner which entered the image.

Browse... is displayed when ICC profile has been previously
specified.
For both Monitor and Input Image, you can read the ICC profile
from any folder. In the selection dialog box of ICC profile, only files
with the ICC profile extension (.icm) will be displayed. Up to 128
file names with the full path can be specified.
The default directories when opening the selection dialog box of
ICC profile are as follows:
NOTE: x is the drive name.
•

Windows 95/98/Me
x:\windows\system\color\

•

Windows NT 4.0:
x:\winnt\

•

Windows 2000
x:winnt\system\spool\drivers\color\

•

Windows XP
x:\winnt\system\spool\drivers\color\

Display the Profile Settings tab to adjust these settings.
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NOTE: When Output Color of the Graphics tab has been set to
Black, the chroma setting cannot be adjusted regardless of the
Print Mode setting.
NOTE: When Image Adjustment Mode of the Graphics tab has
been set to ICM (System) or CMS (Application), or
Complementary Color Conversion, the setting cannot be
adjusted. ICM (System) will only be displayed in Windows 98,
Windows Me, Windows 2000, and Windows XP.

1
2
3

Select Print from the File menu.
Check Printer, and then select Properties.
Select the Graphics tab and then the Profile Settings button.
•

4
5
6
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The Graphics tab will be opened with the Profile Setting
tab displayed.

Select either Color Temperature/Gamma or ICC Profile.
Specify the detailed settings of the selected item.
Select OK.
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Adjusting Detailed Settings
You can adjust the detailed settings of image quality for the entire
document or specific elements like text, graphics, and photos.
The options are as follows:

Options for the Text Group

Options

Contents

Change All Colors to
Black

If the check box is checked, text in
colors other than white/black will be
printed in black when printing color
documents in black and white. This
makes colored text in fine print easier
to see when the text is close in color to
the background.

NOTE: This option is available
when Output Color on the
Graphics or Paper/Output tab has
been selected as Black.
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The following settings are effective for text data only.
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Options for the Graphic Group
The following settings are effective for drawing data such as lines.

Options

Contents

Change All Colors to
Black

If the box is checked, drawing/table/
graph in colors other than white/black
will be printed in black when printing
color documents in black and white.
This makes colored fine lines easier to
see.

NOTE: This option is available
when Output Color on the
Graphics or Paper/Output tab has
been selected as Black.
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Thicken Fine Lines

If the box is selected, fine lines will be
thickened for printing.

Paint Only Enclosed
Areas

If the box is checked, areas defined as
O will not be filled for printing.
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Options for the Photo Group

Options

Contents

Image Compression

Compresses image data like photos within the page for printing.
Options for compression include High Quality and High Compression.
High Quality compresses without loss of image quality. Suitable for data
with many images of the same color like those scanned images in black
and white of business documents.
High Compression is suitable for images like photos. Generally, the
compression effect is high, but there might be a little loss of image quality.
To compress without loss of image quality, select High Quality.

NOTE: Selecting High Quality when printing documents consisting
of only photos will slow down the printing speed. When this occurs,
it is recommended to select High Compression.
Smoothing

High Speed Image
Processing

When this box is checked, the method of resolution conversion of image
data will be changed and the image will be smoothed. If this is not
checked, the printing speed will be faster.
When this box is checked, the images inside the document will be
processed for printing with a shortened processing time.
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These settings are effective only for images like photos.
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Options for the Whole Document
These settings are effective for the whole document.

Options

Contents

Image Enhancement

When this is checked, edges of the whole document will be smoothed.
With this selection the effect of density smoothing might be lost for some
documents that contain images (bitmaps) whose density seems to be
smoothed. When this happens, uncheck the check box. Checking and
unchecking the check box does not change the printing speed.

NOTE: This option is available when Print Mode on the Graphics
tab has been selected as High Speed.
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Draft Mode

When this box is checked, less toner will be used for printing. In general.
The colors will be lighter when this feature is used compared to when it
is not used. Suitable for printing documents whose image quality is not
very important, like draft.

Resolution

Specifies the resolution to be used in the application program when
printing.
Options available: Normal (600 dpi), Layout (300 dpi) and Lines (200
dpi).
Although the resolution of this machine is 600 dpi, selecting Layout (300
dpi) or Lines (200 dpi) will inform the application program which cannot
usually print at 600 dpi, to print at 300 or 200 dpi.
Even if Layout (300 dpi) or Lines (200 dpi) has been selected for
printing, it will not effect the print result much although the dots might
become coarser when fonts have been downloaded.
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Display the Detailed Settings tab to configure these settings.
NOTE: Depending on the application program, the way to display
the printer properties dialog box may differ. Refer to the
application program documentation for details on how to display
printer properties.

Select Print from the File menu.
Check Printer, and then select Properties.
Select the Graphics tab and then the Detailed Settings button.
•

4

The Graphics tab will be opened with the Detailed Setting
tab displayed.

Select the desired options then select OK.
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Secure Print
Secure Print allows you to add a password to your print data on
the computer, send it to the printer for temporary storing; and then
print out the data using the control panel on the printer. You can
also save print data in the printer without a password and print
frequently-used data just from the printer without having to send
print instructions from a workstation. For more information on how
to set the user name and password before printing, refer to the
driver properties settings, in the User Guide (Print).

Setting Secure Print Jobs
In order to use Secure Print, you need to set the user name and
password.

1
2
3

From the Start menu, select Settings then select Printers to
display the printer properties.
Select the Configuration tab.
Select Secure/Sample Print User ID from the Print Features list
box.
Enter the User ID using 24 characters or less at the Secure/
Sample Print User ID text box.
NOTE: The User ID entered here will be displayed as the user ID
on the Secure Print screen on the printer. You can enter the same
user more than once if it is used with different passwords.

4
5
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Enter the password at the Password text box.
Select OK.
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Printing Secure Print Jobs
After setting and sending the Secure Print job at the workstation,
execute print at the printer to output the data.
NOTE: You can also check or delete print jobs saved in the
machine using the same procedure of executing print instruction
at the printer

At the Workstation

1
2
3
4
5
6
7
8
9
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This procedure uses Windows 98 Notepad as an example. The
procedure is the same when using other operating systems.

Select Print from the File menu.
Select the Printer icon, then select Properties.
Select Printing Preferences on the General tab.
Select the Tray/Output tab.
Select Secure Print. The Secure Print screen is displayed.
Select Secure Print from the Print Type drop-down list box.
From Stored Document Name in the Secure Print Settings
group, select either Enter Document Name or Auto Retrieve.
Select OK.
Select OK on the Tray/Output tab.
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At the Printer

1
2
3

4
5

6
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Press the Job Status button on the control panel. The Job Status
screen is displayed.
Select the Secure Print button.
Select your User ID, then select Show Document List.
•

Refresh the document list by selecting Refresh Status.

•

If a password has been set, the password screen will be
displayed.

•

Information about the saved document will be displayed on
the specific user ID screen.

Select the document to be printed, then the Print button. The
Confirmation screen is displayed.
Review the contents displayed, then select from one of the
following selections:
•

If Print was selected in the previous step: Print and
Delete, Print and Save, or Cancel.

•

If Delete was selected in the previous step: Yes or No.

Select Close repeatedly until the Job Status screen is displayed.
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Delayed Print
Delayed Print temporarily stores your print job and allows you to
start print time. You can also start printing prior to the specified
time using the control panel. For more information on how to set
the user name and password before printing, refer to the driver
properties settings, in the User Guide (Print).

1
2

3
4

From the Start menu, select Settings then select Printers to
display the Printing Preferences.
Select one of the following:
•

PostScript Driver: Select Delayed Print on the Output
Settings tab.

•

PCL Driver: Select Delayed Print on the Paper/Output
tab.

Enter the time on a 24-hour basis to start printing in the Start Print
Time box.
Select OK.
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Setting Delayed Print Jobs
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Printing Delayed Print Jobs
After setting and sending the Delayed Print job at the workstation,
the print job will print at the specified time. When printing delayed
print jobs before the specified time set, use the control panel on
the machine.

At the Workstation

1
2

3
4

From the Start menu, select Settings then select Printers to
display the Printing Preferences.
Select one of the following:
•

PostScript Driver: Select Delayed Print on the Output
Settings tab.

•

PCL Driver: Select Delayed Print on the Paper/Output
tab.

From Retrieve Document Name in Delayed Print Settings, select
either Enter Document Name or Auto Retrieve.
Select OK, then select OK on the Output Settings or Paper/Output
tab.

At the Printer

1
2
3
4
5
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Press the Job Status button on the control panel.
Select the Delayed Print button.
Select the document to be printed, then the Print button. The
Confirmation screen is displayed.
Review the contents displayed, then select Yes to print the job or
No to delete the job.
Select Close repeatedly until the Job Status screen is displayed.
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Sample Print
When printing multiple copies, sample print allows you to print out
the first set to check the printing result prior to printing the
remaining copies from the printer control panel.
In order to use Sample Print, you need to set the user name prior
to printing.
Up to 200 users and 1,000 files per user can be set. You can save
up to 9,999 files or until the hard disk is full.

1
2
3
4

From the Start menu, select Settings then select Printers to
display the printer properties.
Select the Configuration tab.
Select Secure/Sample Print User ID from the Print Features list
box.
Enter the User ID using 24 characters or less at the Secure/
Sample Print User ID text box.
NOTE: The user ID entered here will be displayed as the user ID
on the Sample Print screen on printer.

5

Select OK.
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Setting Sample Print Jobs
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Printing Sample Print Jobs
After setting and sending the Sample Print job at the workstation,
execute the print instruction at the printer to print out the data.
NOTE: You can also check or delete print jobs saved in the
machine using the same procedure of executing print instruction
at the printer.

At the Workstation
This procedure uses Notepad of Windows 98 as an example. The
procedure is the same when using other operating systems.

1
2
3
4
5
6
7
8
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Select Print from the File menu.
Select the Printer icon, then select Properties.
Select Printing Preferences on the General tab.
Select the Output Settings tab.
Select Secured Print from the Job Type drop-down list box.
From Stored Document Name in Secure Print Settings, select
either Enter Document Name or Auto Retrieve.
Select OK.
Select OK on the Output Settings tab to start the Sample Print.
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D.

Internet Services

Overview

•

Print from you workstation’

•

Review print jobs

•

Obtain machine and consumable status

•

Download scanned originals

•

Create and edit scan templates

•

Configure the printer (with access rights)
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Internet Services are a series of Web (HTML) Pages located
within the printer that give you access to the printer from your
client workstation using a web browser. You can use Internet
Services to:

Introduction
Internet Services is the embedded HTTP server application that
resides in the Printer. Using a browser (Netscape Navigator 4.x or
Internet Explorer 5.x) you can access any DocuColor 2240/1632
on an IP network using TCP/IP protocol. Simply enter the printer/
copier’s IP address as the URL in the browser.

2–113

USER GUIDE (PRINT)

Screen Structure
The Internet Services screen is made up of four frames.
NOTE: Selecting the Help button located at the bottom frame will
display the on-line Help file which provides information on Internet
Services.

Top Frame
Bottom Frame

Each feature page will display a link to the Home Page, as well as
tabs for moving to each feature.
Typically, it displays links to the Home Page of our company, the
copyright screen and the Help file.
Select the Help button for details on each of the features available
on Internet Services.

Right and Left Frames

The contents of these frames will change according to the
features selected.
NOTE: You can drag the line separating the left and right frames
to change the size of these frames. The position of the line
separating the top and bottom frames cannot be changed.
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System Structure

Target Operating System
The OS and browsers that can be used for Internet Services are
as follows:
•

Microsoft Windows 95

•

Microsoft Windows 98

•

Microsoft Windows 98 Second Edition

•

Microsoft Windows Millennium Edition

•

Microsoft Windows NT Workstation 4.0 (Service Pack 4 or
later)

•

Microsoft Windows NT Server 4.0 (Service Pack 4 or later)

•

Microsoft Windows 2000 Professional (Service Pack 2 or
later)

•

Microsoft Windows 2000 Server (Service Pack 2 or later)

•

Microsoft Windows XP Professional Edition

•

Microsoft Windows XP Home Edition

•

Macintosh OS 10 (Update 1.1 or later)

•

Macintosh OS 9.0
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To use Internet Services, you need to activate an environment
using TCP/IP and enable this software on the machine.
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Browsers
For Windows 95, Windows 98, Windows Me, Windows NT 4.0,
Windows 2000, Windows XP:
•

Netscape Communicator version 4.51 or later

•

Internet Explorer version 5.0 or later

For Macintosh:
•

Netscape Communicator version 4.5 or later

•

Internet Explorer version 5.0 or later

Configuring the Browser
Prior to using Internet Services, check the following setting for
your browser.

Netscape Communicator

1
2
3
4
5
6
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From the Edit menu, select Preferences.
From the Category tree, select Advanced.
Select the + sign on the left of Advanced.
Select Cache under Advanced.
Select Once per session or Every time for Document in cache
is compared to document on network.
Select OK.
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Internet Explorer

2
3
4

Select Internet Options from the Display menu for version 4.x,
and Internet Options from the Tools menu for version 5.x.
Select Settings for Temporary Internet files on the General tab.
For Check for newer versions of stored pages on the Settings tab,
select either Every visit to the page or Every time you start
Internet Explorer.
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1

Select OK.
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Proxy Server and Port Number
Prior to using Internet Services, check the proxy server setting
and port number.

Proxy Server Setting
When using Internet Services, it is recommended to make direct
connection without going through a proxy server.
NOTE: When connection through a proxy server has been made,
it may take a long time to set the IP address using the browser
and the screen may not be displayed. When this occurs, set the IP
address at the browser without going through a proxy server. For
details on how to define these settings, refer to the browser
documentation.

Port Number Setting
The default port number of Internet Services is “80”. The port
number can be changed on the Properties screen > Protocol
Settings > HTTP. The port numbers that can be set at “80” or
“8,000” to “9,999”
To enter the port number at the browser after it has been changed,
you need to add a “:” after IP address or Internet address before
adding it.
For example, specify the port number as follows after it has been
defined as “8080”.
http://IP address: 8080 or http://Internet address: 8080
NOTE: The port number can be checked in the “Maintenance”
item on the “Printer Settings List”. For details on printing the
“Printer Settings “, refer to the System Administrator’s Guide.
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Accessing Internet Services from the Workstation
To access the Printer's Internet Services from your workstation,
set your browser so that it will not try to access the Printer through
a proxy server.

3

Open your Internet Browser program on your workstation.
Enter the Printer's IP Address (as seen on the System Settings
List) into the Address or Location field of the browser.
Press the Enter key on your keyboard. The Home Page for the
machine is displayed.
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Internet Services Features

There are seven features that are available within Internet
Services. Each contains specific options, depending on the task
you are performing. The following list shows the features and their
usage:
Services

You can process print-ready documents using the Services Page.

Jobs

Allows you to view the active processed Job list/job history list and
delete jobs.

Status
Properties

Maintenance
Support
Job Template

Allows you to review the status of the Printer's Trays and
Consumables and displays the host device status.
Allows you to configure the Printer for job processing and network
communications, as well as to download scanned originals from
the Printer to your desktop.
Displays the Printer's error history.
Provides an editable, Internet hot link to an external Customer
Support Site.
Allows you to create, edit, copy, and delete job templates that can
be applied to jobs on the machine.
For more information on Job Template, refer to the Internet
Services Online help system, or the User Guide (Scan).
NOTE: The rectangular button, containing a semi-circular arrow, is
meant to be used to Refresh the current screen.
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Printing Documents Using the Services Feature
Print-ready documents can be quickly and easily submitted for
printing using the Services feature. A print-ready document is a
file that has been formatted and saved for printing from the
application that created it or was printed to file by a print driver.
NOTE: Selecting print and/or finishing options from the Services
feature will override, but not reformat existing PostScript or PCL
print-ready documents.
•

PostScript

•

PDF
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The following formats can be printed from the Services page:
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Printing Documents
To Submit a Document for Printing

1
2
3

4
5

Access Internet Services.
Select the Services tab or select Services from the machine’s
Home Page.
Select your printing options from the drop-down lists according to
your job requirements:
•

Paper Tray

•

Output Destination

•

No. of Sets

•

2 Sided Print

•

File Name

Type the path and file name or select Browse to locate the printready file to process.
When finished with your selections, select the Start button to
process your job.
NOTE: Do not exit the Job Submission Page until the page
redraws after your job has been submitted.
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Viewing/Deleting Jobs Using the Jobs Feature
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You can view all active print jobs that are being processed. Details
of the jobs include the job name, owner, status and type of job,
and the number of sets processed.

Viewing the Active Jobs List

1

Access Internet Services.
For more information on how to access Internet Services, refer to
Accessing Internet Services From the Workstation, in the User
Guide (Print).

2
3

Select the Jobs tab or select Jobs on the machine’s Home Page.
The Job List page is displayed.
Select the Refresh Status button to update the job lists and status
information.
NOTE: Automatic update will not be carried over if a job is being
processed even if Auto Refresh Interval is specified.
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Deleting Jobs

1

Access Internet Services.
For more information on how to access Internet Services, refer to
Accessing Internet Services From the Workstation, in the User
Guide (Print).

2
3
4
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Select the Jobs tab or select Jobs on the machine’s Home Page.
The Job List page is displayed.
Select the check box to the left of the job(s) that you wish to
delete.
Select the Delete button displayed in the top right corner of the
screen’s right panel. The selected job(s) will be deleted.

